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Background Eraser for Sky Replacement

In this lesson, we’re going to learn how we can use the Background Eraser Tool to 
replace skies in our images. The Background Eraser Tool has been in Photoshop 
for a long time, but I find that very few people seem to use it. I’d like to get you 
more comfortable with the settings relating to the tool so that you might start us-
ing it more often. In the process, you’ll also learn many other Photoshop features 
that can be useful for combining two images together. 

Getting Started with the Background Eraser (Timestamp 1:00)

We’re going to use the Background 
Eraser Tool to remove the sky in this im-
age that contains an oil tower and large 
sculpture. The Background Eraser Tool 
can be found in the Toolbar on the left 
side of the interface. It is grouped with 
the regular Eraser Tool. If you click and 
hold on the Eraser Tool icon, you will get 
access to the other tools grouped with 
it. From this menu, you can select the 
Background Eraser Tool.

With the Background Eraser active, a 
series of settings relating to it will ap-
pear in the Options Bar above the main 
image window. We’ll use the brush set-
tings to choose a large brush with a 
hard edge. When we hover the mouse 
over the image, the cursor will appear 
as a round brush with a little crosshair in 
the middle. 

The Background Eraser Tool is grouped with 
the regular Eraser Tool in the Toolbar.

With the Background Eraser Tool active, 
the cursor appears as a round brush with a 
crosshair in the middle.
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When we click the mouse button, 
Photoshop is going to look at what 
color is found underneath that 
crosshair and it’s going to delete 
areas that are similar to that color 
from within the circular brush tip. 
We can click and drag and the tool 
will continue to delete content that 
is similar to what is found under 
the crosshair. This will work well 
for removing this sky in this image, 
as long as I don’t allow the cross-
hair to go over something I want 
to keep. 

When we click with the Background Eraser, the 
tool will erase everything that’s similar to what’s 
found directly beneath the crosshair. 

We’re continuing 
to paint around 
the sky using 
the Background 
Eraser Tool, mak-
ing sure that the 
crosshair doesn’t 
touch any content 
that we want to 
keep.
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Contiguous vs. Discontiguous (3:55)

This image contains a large portion of sky that is broken up into smaller chunks 
by the parts of the oil tower. It is not uncommon to have the content you want 
to remove broken up in to smaller areas by another item in the image. This com-
monly happens with trees and skies. You’ll want to remove the sky, but parts of 
the sky will be visible between tree branches.

With default settings, the Background 
Eraser will not remove content that has 
been separated by the area under the 
crosshair. It only deletes one continuous 
chunk from the image. This is known as 
being contiguous. If you’re dealing with 
an item that’s made up of more than one 
piece, it’s referred to as discontiguous. 

The Limits setting can be found in the 
Options Bar above the image window. 
This is where you can choose between 
Contiguous and Discontiguous. This 
menu is set to Contiguous by default. 
When set to Contiguous, we can use a 
huge brush that covers most of the oil 
tower, but when we click on part of the 
sky that’s contained within the structure, 
it’s only going to erase the piece of sky 
that is uninterrupted by the metal of the 
tower. If we set this menu to Discontig-
uous, we can click within the tower and 
it will erase all parts of the sky that are 
contained within the circular cursor, re-
gardless of whether they’re connected or 
separated by other objects in the image. 

Here, the Background Eraser is set to Con-
tiguous. When we click within the bars, it 
only erases one chunk of sky.

Here, the tool is set to Discontiguous. When 
we click within the bars, it only all areas of 
sky within the round cursor.
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After using the Background Eraser Tool, we’ll zoom in on the image and inspect 
the results. We can see that some of the checkerboard background is visible 
through the structure, which means that it’s partially transparent. This may or 
may not be a bad thing. Since we’re replacing the sky with another sky, it might 
not be noticeable in the end result. 

Replacing the Background (5:26)

With the sky removed from the image, we can now place a new sky in its place. 
We’ll select the new sky image from within Bridge and double-click on it to open 
it in Photoshop. We want to place this sky into the oil tower image so we’ll acti-
vate the Move Tool, click within the image and drag it to the tab containing the 
oil tower image. The oil tower image will come to the forefront and we can move 
the cursor into the image window and release the mouse button in order to place 
the image in this document. If you also hold down the Shift key when moving the 
image, it will center the photo within the document. The sky layer will be on the 
top and we need to place it beneath the oil tower layer, so we’ll drag the sky layer 
thumbnail beneath the oil tower layer in the Layers panel. 

After doing this, we can see that there were a few issues with the old background 
removal, as there are bits of the original sky still visible. We can use the Back-
ground Eraser again to touch up these areas. 

A new sky image was 
placed beneath the oil 
tower layer and we can see 
that there are some rem-
nants from the original sky 
that need to be removed.
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Looking at the area where the tower had become partially transparent, we can 
see that it’s unnoticeable when placed on a new sky layer. 

Adjust Individual Layers (7:30)

The other thing we might want to do is ad-
just the two layers separately so that they 
look like they better belong together. We’ll 
activate the underlying sky layer and then 
we’ll click on the Adjustment Layer icon at 
the bottom of the Layers Panel and choose 
Levels. The Levels adjustment layer will be 
placed directly above the sky layer and the 
Levels settings will appear in the Proper-
ties panel. There are three sliders beneath 
the Levels chart and we’ll drag the Whites 
slider to the left in order to lighten the 
brightest parts of the sky layer. We’ll also 
adjust the Midtones slider until the layer 
looks most natural. Know that this adjust-
ment will be different for every image. 

After removing the sky, we can see that 
some of the structure became partially 
transparent.

We replaced the sky with a new one and the 
area that became partially transparent is no 
longer noticeable.

A Levels adjust-
ment is being 
used to brighten 
the light areas 
in the sky layer.
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We’ll also adjust the oil tower layer, so we’ll make sure that the layer is active 
and we’ll again click on the Adjustment Layer icon at the bottom of the Layers 
panel and we’ll choose Levels from the pop-up menu. This will place the Levels 
adjustment layer above the oil tower layer, at the top of the Layers panel. Be-
cause this adjustment layer is at the top of the Layers panel, it will affect ALL of 
the layers beneath it. We only want the adjustment layer to affect the oil tower 
layer, so we need to clip the adjustment layer 
to the underlying layer. We’ll click on the clip 
icon at the bottom of the Levels Properties 
Panel and this will make it so the adjustment 
layer only affects the layer directly beneath 
it. (The clipping icon looks like a square with 
a downward-pointing arrow next to it.) In the 
Layers panel, the adjustment layer thumbnail 
will become slightly indented and a down-
ward-pointing arrow will appear the left of 
it. Now I can use the Levels adjustments and 
it will only affect the oil tower layer and not 
the sky layer. We’ll just use the Levels slider 
to make an overall brightness adjustment so 
that the tower layer looks like it belongs with 
the sky layer as best as possible. 

The Background Eraser Tolerance Setting (8:54)

One of the Background Eraser settings is called Tolerance and it can be found in 
the Options Bar above the image window (when the tool is active). The Tolerance 
setting determines how much the tool can deviate from the color that is found 
under the crosshair when we click and drag with our mouse on the image. By 
default, the Tolerance is set to 50% and this will delete a pretty wide brightness 
range in relation to the area where you click. If we change the Tolerance to 10%, 
it will delete a much narrower brightness range when we click the mouse button. 

Click this icon at the bottom of the 
adjustment layer properties panel and 
the adjustment layer will only be able 
to affect the layer directly beneath it. 

The adjustment layer has been clipped 
to the underlying layer.
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Gas Station Example Image (11:00)

Let’s replace the sky on another image. This time, we’re going to select (within 
Bridge) both the image with the sky we’re going to replace as well as the image 
containing the new sky. We’ll click on the Tools menu at the top of the Bridge in-
terface and choose Photoshop > Load Files into Photoshop Layers. 

The Tolerance 
setting (circled in 
red) determines 
how far the Back-
ground Eraser 
Tool can deviate 
from the area 
under the cross-
hair. In this docu-
ment, we used a 
large brush and 
clicked on the top 
half with a Toler-
ance of 50%. This 
erased a lot. Then 
we clicked on the 
bottom half with 
a Tolerance of 
10%. This erased 
a much narrower 
range.
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If you’re using Lightroom, you would go to the main menu and choose Photo > 
Edit In > Open as Layers in Photoshop. Both images will be loaded as separate 
layers into a single Photoshop document. 

Crop the image to the size of the gas station layer  We can see that the two 
images are different sizes. The gas station image is shorter than the sky image. 
We’re going to crop the image so that it has the dimensions of the gas station 
image. To do this, we’ll start by creating a selection of the entire gas station layer. 
We can select the entire contents of a layer by holding down the Command key 
(Ctrl on Win) and clicking on the layer thumbnail. The entire layer will become se-
lected, with the “marching ants” selection lines around it. Next, we’ll activate the 
Crop Tool. When you activate the Crop Tool while there is an active selection, the 
crop handles will automatically snap to that selection. In the Options Bar (above 
the image window), there is a “Delete Cropped Pixels” check box. We’ll make sure 
that this check box is turned OFF before locking in the crop. This will allow us to 
keep the part of the sky layer that extends beyond the new document bounds so 
that we can position it to our liking later. We’ll hit the Return/Enter key to crop 
the image and remove the crop handles. 

The two layers are 
different sizes so 
we’re cropping 
the document to 
match the size of 
the gas station 
layer. We will turn 
off the “Delete 
Cropped Pixels” 
check box (circled)
so that the part of 
the sky layer that 
is outside of the 
crop box will not 
be discarded. 
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The History Panel (13:38)

At this point, there are a couple of settings that we might want to change. I 
change these all the time when I’m using the Background Eraser tool. 

History States We’ll click on the Photoshop menu at the top of the screen and 
choose Preferences > Performance. Note that in Windows, the Preferences will 
be found under the Edit menu. The Preferences dialog will appear and the Per-
formance category will be at the forefront. On the right side of the dialog is the 
History States setting. This determines how many undos you’re capable of using. 
When using the Background Eraser, I find that I click a lot to remove different 
parts of the background, so there are a lot of history steps that need to be re-
corded. Because of this, I like to allot myself a lot of history states so I will put this 
setting at 100 and click OK to exit the Preferences dialog. 

New Snapshot The next setting will allow 
us to bring parts of the image back if we 
accidentally erase some areas. We’ll click 
on the Window menu and choose History. 
This will open the History panel. We’ll click 
on the little menu in the top right corner of 
the panel and choose New Snapshot. The 
New Snapshot box will appear and we’ll 
set the “From” menu to “Merged Layers,” 
we’ll name the snapshot “Original Subject” 
and click OK. 

When you create a new snapshot, it’s going to remember what your picture looks 
like at this particular stage. If you choose the Merged Layers option, it’s going to 
act as if it’s a flat image, with all the layers combined together. 

The History Brush We’re going to be using the History Brush, which is going to 
allow us to paint on the image to bring the image back to how it used to look at 
a specific stage in time. We determine what stage that is from within the History 
Panel. The History Panel contains a list of everything we’ve done to the image. To 
the left of each history state is a little box and if we click on one of the boxes, it will 

A new snapshot is being created from the 
merged layer view.
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place a History Brush icon there. 
This means that if we paint with 
the History Brush, we’ll be paint-
ing in that specified state in his-
tory.  Any snapshots will appear 
at the top of the History panel 
and we’ll click to the left of the 
snapshot we just created so that 
the History Brush icon is placed 
there. This tells the History Brush 
to paint with that snapshot. 

Now let’s try out the Background 
Eraser Tool to remove the sky 
in this image. We’ll activate the 
Background Eraser and use a 
large brush to click on the left 
side of the image. When we do, 
we see that the current sky gets 
erased to reveal the underlying 
sky layer, but we can also see the 
building changing color a bit. This 
means that the Background Eras-
er is partially erasing the building, 
and that’s not what we want. This 
is happening because the Tol-
erance setting is at 50%, which 
means that the tool can deviate 
a good amount from the color 
under the crosshair when erasing 
parts of the image. At the current 
setting, it thinks that the building 

We clicked the box to the left of the Original Subject 
snapshot to place the History Brush icon there. This 
tells the brush to use that snapshot when we paint.

We started to paint over the sky with the Background 
Eraser Tool and we can see that the building is being 
affected as well. We’ll need to use the undo command 
and then paint again using a lower Tolerance setting. 
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is close to the same color as the sky. We need to lower the Tolerance setting sig-
nificantly so that it can’t deviate very far from the blue of the sky. We’ll set the 
Tolerance to 20% and try again. This is better, but it’s still erasing part of the white 
cap on the building. That’s going to be an area that we’ll bring back later using the 
History Brush, so we’ll continue painting over the sky with the Background Eraser, 
making the brush smaller as necessary. 

There are areas where the building is very close to being the same color as the 
sky, so it’s going to be very difficult to prevent part of the building from be-
ing erased, no matter how small of a brush we use. Because we’re not working 
non-destructively (on a separate, empty layer), there are parts of the building 
that will be erased from the document. This is where we’ll be using the History 
Brush and that snapshot we created to bring parts of the image back. 

We lowered the Tolerance setting and continued to paint over the sky area with the Back-
ground Eraser Tool. 
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Using the History Brush The History Brush can be found di-
rectly above the Eraser/Background Eraser Tools in the Tool-
bar on the left side of the interface. We’ll click on it to activate 
it. We previously set up the History panel so that the History 
Brush would know which version of the image to paint with. 
We created a snapshot of the original image, and when we 
paint with the History Brush, it’s going to be painting with that 
snapshot. 

We’ll turn off the visibility of the sky 
layer so that we’re viewing the gas sta-
tion layer on the transparent check-
erboard background. This will help to 
see which parts of the building need 
to be restored. We’ll use a small, hard 
brush and start to paint over the part 
of the building that had accidentally 
been erased. 

Parts of the build-
ing were accidentally 
erased with the Back-
ground Eraser Tool. 
We’ll bring these areas 
back using the History 
Brush.

The History Brush 
can be found in the 
Toolbar.

The History Brush is being used to paint over 
the part of the building that had accidentally 
been erased.
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Options Bar Icons (24:02)

Zooming in on the image, I can see that there are 
a few areas between the leaves of the trees that 
had not been erased. We’ll activate the Back-
ground Eraser Tool again so we can try to erase 
those areas. If we click once, placing the cross-
hair on part of the sky that shows through be-
tween the leaves, it will erase that piece of sky. 
If we click and drag, however, we’ll be erasing 
part of the tree because the crosshair will have 
moved over the leaves, causing the tool to erase 
everything of the same color. There is a setting 
where we can change that, making it so the tool 
only erases areas that are the same color as the 
where the crosshair was initially clicked. 

There are three icons in the Options Bar and the 
one on the left is active by default. With this set-
ting, the Background Eraser will continuously 
monitor the color that’s underneath the cross-
hair. The icon in the middle will tell the tool to 
only pay attention to what’s under the crosshair 
ONCE, when you make that first click with the 
tool. It will then pay attention to only that color 
for the entire time you’re dragging. When using this setting, we can click within 
the leaves of the tree, making sure that the crosshair is targeting a piece of sky, 
and drag around the tree area. This will erase all of the bits of sky between the 
leaves without erasing the leaves themselves. 

The third icon in the Options Bar will tell the Background Eraser to delete any-
thing that matches the current background color. This setting would be useful if 
you couldn’t get to the color to click on it with the crosshair. This could happen if 

With default settings, the Back-
ground Eraser will continue to re-
move whatever is similar to what’s 
under the crosshair as we paint.

When the Background Eraser is 
active, these three settings will ap-
pear in the Options Bar.
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the area is partially transparent so you could only see the tiniest hint of it. 

Now we can toggle the visibility of the sky layer and see that the old sky has been 
successfully removed. With the sky layer visible, we can use the Move Tool to bet-
ter position it so that the clouds appear in a desirable position. 

Adjustments to Prepare an Image for Sky Removal (27:13)

Before opening an image into Photoshop for sky removal (or other background 
removal), it can be useful to determine if there is anything we can do it before-
hand in order to get more optimal results. Let’s look at what kinds of adjustments 
we can do before moving to Photoshop. From Bridge, we can open a raw file in 
Camera Raw simply by double-clicking on it. If the file is a jpeg, we could go to 
the File menu and choose to Open in Camera Raw. 

In Camera Raw, we want to make sure 
that there is no artifact around the edges 
of objects that would affect the perfor-
mance of the Background Eraser. We’ll 
click on the Lens Corrections tab on the 
right side of the interface. (The icon looks 
like the separate elements of a lens.) At 
the top of this panel are two check box-
es. The first is titled “Remove Chromatic 

LEFT: The sky was successfully removed. RIGHT: The new sky layer was placed behind the 
gas station layer and positioned so that the clouds look ideal.

We’re turning on the two check boxes in 
the Camera Raw Lens Corrections Tab.
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Aberration.” Chromatic Aberration is the colored halo that can appear along the 
edges of high contrast objects, like trees against a bright sky. We’ll turn this check 
box on to remove this artifact. We’ll also turn on the “Enable Profile Corrections” 
check box because it will remove any distortion caused by the lens. 

If the image was shot with a high ISO setting, we’ll also want to do some noise re-
duction. The noise reduction settings can be found under the Detail tab in Cam-
era Raw (The icon looks like two triangles overlapping.) 

The last adjustment we’ll want to 
do before moving to Photoshop 
is to make sure that the white 
balance is appropriate. If there is 
any kind of color cast to the im-
age. It will be difficult to remove 
the background using the Back-
ground Eraser because the back-
ground will be similar in color to 
the subject. The Temperature and 
Tint sliders collectively control 
the white balance and they can 
be found under the Basic tab in 
Camera Raw (the left-most tab).  
If the Temperature slider is too far 
to the right, the image will look 
yellow and if it’s too far to the left, 
everything will look blue. We’ll 
move the slider back and forth, 
stopping at the point where we 
see the most separation in the 
colors. We’ll do the same thing 
for the Tint slider. 

The Temperature and Tint sliders are being adjusted 
to ensure that the image’s white balance is correct 
before removing the sky in Photoshop.
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After making these initial adjustments, we’ll click the Open Image button at the 
bottom of the Camera Raw interface. This will open the image in Photoshop. 

Tree Image Example (30:06)

The image we’re working on in the video example has a large tree with a cloud-
less sky behind it. We’re going to remove the sky and replace it with a different 
sky that contains clouds. We’ll first bring the new sky into the document, placing 
it on a separate layer that is positioned beneath the tree layer. 

We’ll activate the Background Eraser Tool and adjust the settings that we want 
the tool to start with. We’ll set the Tolerance to 40% and make sure that the left-
most icon is selected, which will tell the tool to continuously monitor the color 
that’s beneath the crosshair in determining what to erase. We’ll then use a large 
brush to paint over the sky and around the tree. As we paint to remove the cur-
rent background, the new background sky will start to become visible in the un-
derlying layer. 

We’re painting over the sky with the Background Eraser and we can see the underlying sky 
layer come into view.
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After painting all the way around the tree, we’ll make the brush very large (large 
enough to encompass the tree) and place the crosshair in a small patch of sky 
somewhere within the tree. We’ll click once to remove the sky from within the 
tree area. If this deletes part of the tree itself, we’ll use the Undo command and 
lower the Tolerance setting before trying again. In the video example, we set the 
Tolerance at 20%. 

This is also a good example of where we could use the third icon in the Options 
Bar. This is the one that would cause the Background Eraser to delete the spec-
ified background color in the area where we paint. Because the patches of sky 
within the tree are so small, it’s hard to get the crosshair to target the correct 
blue. If we set the background color to a similar blue, we could use that third icon 
setting to remove the blue that we set as the background color. 

Reset the tool After using the Background Eraser Tool, 
it’s a good idea to set the tool’s settings back to normal, 
with a Tolerance of around 40% and the left-most icon 
setting selected in the Options Bar. This just makes it 
so that the next time you use the tool, you’re starting 
with standard settings. 

Now that the sky has been replaced, we can see that 
the new sky looks a little dull and doesn’t look quite 
like it belongs with the rest of the image. We’ll use an 
adjustment layer to make it look better. With the sky 
layer active, we’ll click on the Adjustment Layer icon at 
the bottom of the Layers panel and choose Levels from 
the pop-up menu. This will add a Levels adjustment 
layer directly above the sky layer in the Layers panel. 
Within the Properties panel, we’ll adjust the Levels slid-
ers to make the bright areas even brighter, dragging 
the whites slider to the left until the sky layer looks like 
it has enough pop to match the foreground layer. 

A Levels adjustment layer is 
being used to make the sky 
layer pop a little more.
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At this point, we’ll examine the image and we can see that there is some resi-
due left over from the use of the Background Eraser Tool. We can see the shape 
of the brush in parts of the sky. When this happens, we’ll need to return to the 
Background Eraser Tool to fix it. We’ll activate the tool and re-paint over the area, 
making sure the crosshair overlaps the problem area. If it doesn’t show any im-
provement, we’ll need to increase the Tolerance setting and try again. 

Fall Foliage Sky Replacement (38:07)

Let’s look at another image. In the next example, we have a photo of some trees 
with fall color against a blue sky. It’s a raw image that we’re viewing in Bridge 
so we’ll double-click on it to open it in Camera Raw. This is where we’ll do some 
initial adjustments before replacing the sky in Photoshop. Zooming in on the im-
age, we can see that there is a lot of chromatic aberration where the leaves meet 
the bright sky. This is in the form of undesirable purple and green halos around 
the leaves. To correct for this, we’ll click on the Lens Corrections tab on the right 
side of the Camera Raw interface and we’ll turn on the “Remove Chromatic Ab-

LEFT: The Background Eraser left a little residue that you can see as a circular brush shape. 
RIGHT: We are painting some more with the Background Eraser to remove the residue. 
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erration” check box. This caused the green halos to go away, but the purple ones 
remain. We’ll need to remove these manually. At the top of the Lens Corrections 
panel, we’ll switch from the Profile tab to the Manual tab. Here, we’ll find some 
settings where we can tell it the range of colors it can work on and an Amount 
slider, which determines how much it should try to reduce that particular color 
range. We’ll adjust these sliders and drag the Purple Amount slider up until we 
can see the halos disappear. 

When we’re satisfied with the initial adjustments, we’ll click the Open Image but-
ton in the bottom right corner of Camera Raw’s interface. This will open the im-
age in Photoshop. We’ll find the image that is going to be used as the new sky 
and we’ll open it in the same Photoshop document. In this example, the tree im-
age is horizontal and the sky image is vertical. Before moving the sky image into 
the trees document, we’ll click on the Image menu and choose Image Rotation > 
90 degrees clockwise. Now, when we move the image into the other document, 
both layers will be at the same orientation. 

The sky image contains some land, so we’ll need to scale the layer up so that it’s 
only sky that’s filling the frame. We’ll click on the Edit menu and choose Trans-

ABOVE: Colored halos appear around 
the leaves. RIGHT: In the Lens Correc-
tion tab of Camera Raw, the Manual 
settings are being used to remove the 
chromatic aberration.
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form > Scale and the transform handles will appear around the layer. We’ll click 
and drag on these handles to scale the image up so that the land disappears from 
the frame. We’ll tap the Enter key to lock in the transformation. 

The sky layer is currently positioned above the trees layer, so we’ll switch that to 
make sure that the trees are the top layer and the sky is the bottom layer. 

We’ll activate the Background Eraser Tool. For this particular image, it’s going to 
be difficult to use the tool with the left-most icon selected in the Options Bar. This 
is the one that will tell the tool to constantly watch the color that’s beneath the 
crosshair and erase whatever color that is. This image contains so many trees that 
it will be hard to paint without the crosshair moving over the leaves. We’ll click 
on the second icon, which will tell the tool to erase only the color that’s under the 
crosshair when we initially click within the image. 

Using a large brush, I’ll position the crosshair over a light part of the sky and I’ll 
click and drag to paint around the image, keeping the mouse button held down 
as I do so. We’ll start to see the underlying sky image come into view in the areas 
where the current sky is being removed. To get a better view of what is being 
erased, we’ll turn off the visibility of the sky layer so that we see the checkerboard 
background instead. 

We’re painting to erase the sky using the background Eraser Tool. The underlying sky layer 
has its visibility turned off so that we see the checkerboard showing through.
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Now we’ll position the crosshair over part of the background area where we can 
still see some blue sky left over. We’ll click and drag around the image to erase 
everything that is that shade of blue. It looks like we’ve done a good job of re-
moving the original sky, so we’ll turn the visibility of the underlying sky layer back 
on and zoom in to inspect. Looking closely at the leaves, we can still see residue 
from the old sky left over. It’s appearing as a border around many of the leaves, so 
it’s going to be hard to target with the crosshair. This is another example of where 
the third icon setting in the Options Bar will be useful. This is the setting that tells 
the tool to erase anything that is similar to the current background color. We’ll 
set the background color to match the old sky residue as closely as possible and 
then we’ll start to paint over the image. This does a much better job of cleaning 
up what’s left over from the original sky. 

The “Protect Foreground Color” Feature (45:53)

In the next image of a scene from Africa, we again placed a new sky layer beneath 
the Africa layer and we used the Background Eraser to remove as much of the 
sky as possible.

LEFT: There is some residue from the old sky around the edges of the leaves. RIGHT: We set 
the background color to match the old sky residue and used the third icon setting in the Op-
tions Bar to paint over the sky, removing everything that matches the background color.
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When we get to the area around the 
trunk of the tree, we run into some 
problems because the tree trunk is 
similar in color to the sky in that area 
of the picture. We end up deleting too 
much, so we’ll undo and try a differ-
ent technique for this area. We’ll hold 
down the Option key (Alt on Win) to 
temporarily access the Eyedropper 
Tool and we’ll click within the bright 
area in the tree trunk. This will sample 
the color and set it as the foreground 
color.  We’ll then turn on the “Protect 
Foreground Color” check box within 
the Options Bar above the image window. Now we’ll try the Background Eraser 
again and we’ll find that it does not delete part of the tree like it did previously. 
Whenever you use that “Protect Foreground Color” setting, just remember to 
turn it off when you’re done because it could potentially create problems when 
using the tool in the future. 

Setting up the History Brush (48:48)

The Background Eraser also runs into problems where the sky meets the ground. 
Part of the ground ends up being deleted. Here, we’ll use the History Brush to 
bring the area back. We didn’t previously set up the History Panel so the Brush 
would know what state of history to paint with, so we’ll need to set that up before 
we can start painting with the History Brush.

We’ll open the History panel, which displays a list of everything we’ve done to the 
picture since we opened it. If we click back through the different steps, it will revert 
the image to what it looked like at that stage. We’ll click back through the steps 

The Background Eraser Tool ended up erasing 
part of this tree trunk. We’ll need to undo and 
use the “Protect Foreground Color” feature to 
prevent this.
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until we find a stage that was before 
we started changing that Africa lay-
er. With that step selected, we’ll click 
on the little menu in the top right 
corner of the History panel and we’ll 
choose New Snapshot from the pop-
up menu. The New Snapshot dialog 
will appear and we’ll set the “From” 
menu to Merged Layers. We’ll type in 
“Original Subject” for the name and 
we’ll click OK. The new snapshot will 
appear near the top of the History 
panel and we’ll click the little square 
to the left of its thumbnail in order 
to place the History Brush icon there. 
This tells the History Brush to paint 
with this image state. Now we can 
click on the very last of the history 
steps so that the image goes back to 
looking the way it should after using 
the Background Eraser. 

We’ll activate the History Brush and 
paint over the part of the ground that 
accidentally got partially erased. This 
will bring back that part of the image 
to its original state. We can now ac-
tivate the sky layer and use the Move 
Tool to position the clouds in the po-
sition that looks most ideal. 

With the appropriate history state active, we 
clicked on the upper right menu in the History 
panel and are choosing to create a new snap-
shot.

The snapshot appears at the top of the History 
Panel and we clicked to the left of the thumb-
nail to place the History Brush icon there.
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Working Non-destructively with Layer Masks (54:19)

There are some times when you’re going to want to convert this into a layer mask. 
A layer mask is nondestructive in that you can paint on the mask with white in 
order to bring back parts of the layer. The History Panel technique IS destructive 
in that the History list gets cleared out every time you close the file. 

You should be aware, however, that any time you convert this into a layer mask, it 
won’t look identical because we’re shifting the colors around the edges a bit and 
we’re going to lose that shift when we convert to a layer mask. 

If you’d rather use a layer mask, go to 
the Layers panel when you’re done re-
moving the background on an image, 
hold down the Command key (Ctrl on 
Win) and click on the layer thumbnail. 
This will create a selection around 
the contents of the layer (everything 
that’s not transparent). Next, click on 
the Layer Mask icon at the bottom of 
the Layers panel. This will convert the 
selection into a layer mask. In the Lay-
ers panel, click on the thumbnail for 
the image to make sure that it’s active. 
You want the image to be active, not 
the mask. Little white brackets will ap-
pear around the thumbnail to indicate 
that it’s active. 

Click on the Edit menu and choose Fill. The Fill dialog will appear and you’ll want 
to set the Contents menu to History. This will do a similar thing as the History 
Brush, but instead of filling with history in the area where you paint, it’s going to 
fill the entirety of the image with it. Click OK to exit the Fill dialog and the image 
will be filled with the history snapshot that we designated earlier. The layer mask 

The results of the sky removal were converted 
into a layer mask. Here, we clicked on the im-
age icon to make the image active. The white 
brackets around the thumbnail indicate that 
the image is active, not the mask.
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will limit the part of the layer that’s visible to the subject and foreground (the part 
that wasn’t erased with the History Brush).  

If you convert to a layer mask and find out that the colors don’t look quite right 
along the edges in the image, you may want to try one additional step. Go to the 
Layers panel and click on the layer mask to make it active. Little white brackets 
should appear around the thumbnail, indicating that the mask is active. Then, click 
on the Select menu at the top of the screen and choose Select and Mask. The 
Select and Mask window will appear and you’ll want to change the View menu 
to On Layers. This will set the preview to show the layer as it appears on top of 
the underlying sky layer. Scroll down to the bottom and find the Output Settings 
category, which includes the “Decontaminate Colors” check box. This setting will 
look at the edges of the images and find any areas that are partially transparent. 
If it finds any residual colors from the old background, it will try to eliminate it. 
Turn this check box on and then work with the Amount slider directly beneath 
the check box. Drag this slider all the way to the left and then slowly bring it up, 
finding the lowest setting that fixes the edges in the image. 

In the Select and Mask window, the “Decontaminate Colors” check box is being turned on, 
which is removing the colored residue around the edges of the mask.


